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1 Visão Geral
1.1 Design modular

O sistema Access Professional Edition (mencionado aqui como Access PE) fornece controle
de acesso autônomo para pequenas e médias empresas. Ele consiste em vários módulos:
– LAC Service: um processo em constante comunicação com os LACs (Controladores de

Acessos Locais – denominados a partir de agora como Controladores). Os AMCs
(Controladores Modulares de Acesso) são usados como Controladores.

– Configurador
– Gerenciamento de funcionários
– Visualizador do histórico
– Gerenciamento de alarmes
– Verificação por vídeo

1.2 Módulos de servidor e cliente
Os módulos podem ser divididos em módulos de servidor e módulos de cliente.
O LAC Service necessita permanecer em contato constante com os controladores, em
primeiro lugar, porque está constantemente recebendo mensagens destes relativas a
movimentos, presença e ausência de usuários de cartões e, em segundo lugar, porque
transmite aos controladores alterações aos dados, p. ex., atribuição de novos cartões, mas
sobretudo porque efetua verificações de metanível (verificações das sequências de acesso,
verificações de antirretorno, revista aleatória).
O Configurador também deve ser executado no servidor, no entanto, pode ser instalado em
estações de trabalho de clientes e operado a partir delas.
Os módulos Gerenciamento de funcionários e Visualizador do histórico pertencem ao
componente de Cliente e também podem ser executados no Servidor ou em outro PC com
uma conexão de rede ao servidor.
Os seguintes Controladores podem ser usados.
– AMC2 4W (com quatro interfaces de leitor Wiegand) - pode ser ampliado com uma AMC2

4W-EXT
– AMC2 4R4 (com quatro interfaces de leitor RS485)
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2 Geral
2.1 Introdução

O Access PE é um sistema de controle de acesso concebido para oferecer os mais elevados
padrões de segurança e flexibilidade em instalações de pequeno e médio porte.
O Access PE deve a sua estabilidade e possibilidade de atualização a um projeto de três
camadas: a primeira camada é a de administração com os seus serviços de controle. Todas as
tarefas administrativas são aqui executadas, por ex., o registro de novos cartões e a atribuição
de direitos de acesso.
A segunda camada é formada pelos controladores de acessos locais (LACs) que controlam
cada grupo de portas e entradas. Mesmo quando o sistema está offline, um LAC é capaz, de
forma independente, de tomar decisões de controle de acesso. Os LACs são responsáveis
pelo controle das entradas e dos tempos de abertura da porta ou pela solicitação de códigos
PIN em pontos de acesso críticos.
A terceira camada consiste em leitores de cartão.
A comunicação entre cliente, servidor e usuários de cartões é criptografada por AES.
A versão multi-usuário do Access PE permite que várias estações de trabalho controlem o
sistema. Os níveis de direitos do usuário configuráveis restringem o acesso e garantem a
segurança. Desta forma, é possível, por exemplo, manter os dados do cartão a partir de uma
estação de trabalho enquanto usa outra para verificar se um funcionário se encontra no
edifício
O Access PE oferece uma configuração excepcionalmente flexível dos direitos de acesso,
modelos de tempo e dos parâmetros de entrada. A seguinte lista fornece uma visão geral das
características mais importantes:
Atribuição fácil e rápida de cartões
Os cartões (até três) podem ser atribuídos a pessoas manualmente ou usando um leitor de
cadastramento conectado a um PC por meio de uma conexão serial. Todos os cartões
atribuídos estão ativos. Na atualização dos cartões, o cartão antigo é automaticamente
substituído e torna-se inválido, evitando assim que cartões antigos tenham acesso, mesmo
que os responsáveis os tenham esquecido ou não tenham conseguido cancelá-los.
Direitos de Acesso (incluindo Privilégios do Grupo)
Cada pessoa pode herdar privilégios do grupo, bem como ter direitos individuais atribuídos.
Os privilégios podem ser restritos por área e tempo com uma precisão de um minuto. Os
privilégios do grupo podem ser utilizados para conceder e limitar os direitos de acesso para
qualquer ou para todos os usuários de cartão simultaneamente. Os privilégios do grupo
podem estar dependentes de modelos de tempo, o que restringe o acesso em determinados
períodos do dia.
Rastreamento de Acesso
Ao definir áreas é possível seguir e cumprir uma sequência correta de acessos. Mesmo sem
monitoração, esta configuração torna possível exibir a localização do usuário do cartão.
Anti-Dupla Entrada 
Quando um cartão for lido, pode ser bloqueada a sua entrada a este mesmo ponto de acesso
durante um período de tempo definido. Assim, é possível evitar a "dupla entrada", em que um
usuário passa o seu cartão através de uma barreira para proporcionar acesso a uma pessoa
não autorizada.
Cancelamento Automático de Cartões em caso de Expiração
Visitantes e pessoal temporário necessitam frequentemente de acesso apenas durante um
período limitado.
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Os cartões podem ser registrados para um período de tempo específico, de modo a que
percam automaticamente a sua validade assim que esse período expire.
Modelos de Tempo e Modelos de Dia
Modelos específicos de tempo podem ser atribuídos a um usuário do cartão que regulam as
horas que essa pessoa tem acesso. Os modelos de tempo podem ser definidos de forma
flexível utilizando modelos de dia que determinam como é que dias da semana específicos,
fins de semana, feriados e dias especiais diferem dos dias de trabalho normais.
Identificação através de Código PIN
Em vez de um cartão, uma pessoa pode usar um Código PIN especial para entrar.
Verificação através de Código PIN
As áreas particularmente sensíveis podem ser programadas de forma a exigirem Códigos PIN
adicionais. Esta proteção pode, por sua vez, ser dependente de modelos de tempo para que,
por exemplo, apenas seja necessário um Código PIN para o acesso durante períodos de férias
ou fora do período de expediente.
Flexível Gerenciamento da Porta
A parametrização flexível de modelos de porta individuais permite um ótimo equilíbrio entre a
segurança e o conforto. O período de "shunt" ou de supressão de alarme pode ser
especificado individualmente para regular durante quanto tempo uma porta deve permanecer
aberta. Em cooperação com um sistema de alarme, o ponto de acesso pode então ser
opcionalmente travado.
Desbloqueio Periódico da Porta
Para facilitar o acesso, os alarmes da porta podem ser "shuntados" para desbloquear as
portas durante períodos de tempo específicos. Os períodos de desbloqueio da porta podem
ser definidos manual ou automaticamente através de um modelo de tempo.
Apontamento de Frequência
Os pontos de acesso podem ser parametrizados para registrar a entrada e saída para fins de
apontamento de frequência.
Design do Cartão 
O módulo gráfico suplementar Card Personalization (CP) (Personalização de Cartão) está
completamente integrado no sistema de controle de acesso para permitir ao operador criar
cartões sem mudar de aplicações.
Atribuição de Fotografias
Se o módulo suplementar Card Personalization (CP) (Personalização de Cartão) não estiver
ativado, a identificação através de fotografia pode, apesar disso, ser realizada através da
importação da fotografia e respectiva associação aos usuários de cartão.
Sistema de bloqueio offline
As áreas que, por algum motivo, não estão cobertas pela alta disponibilidade do sistema de
controle de acesso online, podem, apesar disso, ser travadas offline.
Administração de dispositivos de vídeo
As entradas podem ser adicionalmente equipadas com câmeras para identificar e seguir os
movimentos das pessoas que as estão utilizando.

2.2 Iniciar sessão (login) do usuário
Os seguintes aplicativos estão disponíveis. Consulte os respectivos manuais do usuário para
mais detalhes:

Gerenciamento de pessoal
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Configurador

Visualizador do histórico

Gerenciamento de Mapas e Alarmes

Verificação por vídeo

Aviso!
Só é possível fazer o login a partir do cliente se o serviço LAC estiver em execução no
servidor.

Login do cliente
Os aplicativos do sistema estão protegidos contra uso não autorizado. As senhas padrão no
primeiro uso são:
– Nome de usuário: bosch
– Senha: bosch

Após a inserção do nome de usuário e senha, o botão Change Password (Alterar senha) fica
ativo.
Após três tentativas incorretas, será necessário aguardar um momento antes de tentar fazer o
login novamente. Isso vale para os botões "Start the Application" (Iniciar o aplicativo) e
"Change Password" (Alterar senha).
A lista suspensa na parte superior pode ser usada para selecionar o idioma de interação
desejado. O idioma predefinido é aquele que foi usado para instalar o aplicativo. Se houver
uma mudança de usuário sem reiniciar o aplicativo, é mantido o idioma anterior. Por este
motivo, é possível que apareça uma caixa de diálogo em um idioma indesejado. Para evitar
isto, volte e inicie a sessão do Access PE.
Os aplicativos do Access PE podem ser executados nos seguintes idiomas:
– Inglês
– Alemão
– Francês
– Japonês
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– Russo
– Polonês
– Chinês (PRC)
– Holandês
– Espanhol
– Português (Brasil)

Aviso!
Todas as opções, como nomes de dispositivos, rótulos, modelos e esquemas de direitos dos
usuários, são exibidas no idioma em que tiverem sido inseridas. Igualmente, os botões e
rótulos controlados pelo sistema operacional podem ser exibidos no idioma do sistema
operacional.

Após clicar no botão Change Password (Alterar senha), insira um novo nome de usuário e
uma nova senha nesta caixa de diálogo:

Aviso!
Não se esqueça de alterar a senha!

O botão Start the application (Iniciar o aplicativo) verifica os privilégios do usuário e, com
base neles, inicia o aplicativo. Se o sistema não conseguir autenticar o início de sessão,
aparecerá a seguinte mensagem de erro:Nome de usuário ou senha incorretos!
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2.3 Layout do gerenciamento de funcionários
A caixa de diálogo é composta pelas seguintes partes:

1 = Barra de menus — contém as funções da caixa de
diálogo apresentadas de acordo com a ordem do menu.

2 = Barra de ferramentas — contém teclas de atalho para as
funções da caixa de diálogo mais importantes.

3 = Barra de título — corresponde ao Windows padrão e
contém botões para minimizar ou fechar a janela de
diálogo. O nome do usuário atual é mostrado entre
colchetes.

4 = Tabela de funcionários — lista todas as pessoas
reconhecidas no sistema, assim como o status da sua
presença (autorização e localização).

5 = Campo da caixa de diálogo — a primeira vez que este
campo é aberto ou quando não existe nenhum usuário
conectado, é exibida uma imagem neutra. Quando é
selecionada uma entrada a partir da Lista de
funcionários, os dados dessa pessoa são exibidos.

6 = Histórico de acessos online — lista as últimas cinco
pessoas (com imagem no banco de dados) que
passaram os respectivos cartões na entrada
selecionada.

7 = Status do dispositivo — lista os dispositivos e entradas
configurados, assim como o respectivo status de
conexão. Disponibiliza funções de controle de portas.

8 = Apresentação de eventos — as falhas são indicadas por
uma barra vermelha intermitente (que pisca três vezes)
com detalhes sobre a causa.
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9 = Barra de status — exibe informações sobre botões e
entradas de menu que são controladas pelo cursor.
Visualização do status do programa Card
Personalization (CP) (Personalização de Cartões),
leitores de cadastramento e LAC-Service.

2.4 Barra de ferramentas do Personnel Management
As seguintes funções estão disponíveis por meio dos menus ou ícones.

Função Ícone Descrição

Menu Options (Opções)

Atualizar Atualiza a lista de funcionários

Sair Sai do aplicativo Access PE
Personnel Management

Menu Persons (Pessoas)

Nova pessoa Abre uma nova caixa de diálogo
de dados do cartão e de
funcionários

Modificar pessoa Abre a caixa de diálogo de
dados do cartão e de
funcionários com os dados da
pessoa selecionada.

Excluir pessoa Exclui a pessoa selecionada
(depois de confirmar uma caixa
de diálogo de verificação de
segurança).

Transmitir pessoa
selecionada ao
LAC Service

Transmite os dados da pessoa
selecionada ao LAC Service e
informa se a operação foi bem-
sucedida.

Transmitir todas
as pessoas ao LAC
Service

Transmite todos os dados das
pessoas ao LAC Service e
informa se a operação foi bem-
sucedida.

Definir todas as
pessoas ausentes

Define todas as pessoas
ausentes (depois de confirmar
uma caixa de diálogo de
verificação de segurança).

Definir a
localização de
todas as pessoas
presentes como
desconhecida

Define a localização de todas as
pessoas como desconhecida e
desativa o rastreamento de
acesso para o próximo registro
de cada pessoa.
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Função Ícone Descrição

Apagar pessoas Abre a caixa de diálogo para
apagar o banco de dados da
pessoa

Visualizar/
imprimir relatórios

Abre a caixa de diálogo para
criar listas de relatórios.

Control
e de
listas

Restringe as pessoas mostradas
aos componentes do grupo
selecionado.

Menu View (Visualizar)

Barra de símbolos Alterna a exibição da barra de
ferramentas. Padrão = ativada.

Barra de status Alterna a exibição da barra de
status. Padrão = ativada.

Dados de
funcionários:
Estado
Nº do cartão
Nº de matrícula
Empresa
Grupo de
funcionários
Telefone
Local

Escolha das colunas exibidas na
visão geral dos dados de
funcionários, além das colunas
do símbolo e nome.
Padrão = Estado - Empresa -
Localização

Menu Door management (Gerenciamento de portas)
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Função Ícone Descrição

abrir porta Estas
funçõe
s
també
m
estão
disponí
veis
por
meio
do
menu
de
context
o
(clique
com o
botão
direito
do
mouse
na
porta/
entrada
deseja
da)

A entrada selecionada na lista
de dispositivos é exibida e pode
ser aberta (uma única vez).

Abertura de longo
prazo

A entrada selecionada na lista
de dispositivos é exibida e pode
ser aberta (por longo prazo).

travar porta A entrada selecionada na lista
de dispositivos é exibida e pode
ser travada.

Menu Tools (Ferramentas)

Login de usuário Fazer login/logout do Personnel
Management.

Executar o
Configurator

Executa o Configurator e
transfere os dados do
Personnel Management.

Executar o
visualizador do
histórico

Executa o visualizador do
histórico e transfere dados do
Personnel Management.

Executar
verificação por
vídeo

Inicia o aplicativo para executar
a verificação por vídeo.

Executar
gerenciamento de
alarmes e mapas

Inicia o Visualizador de Mapas e
o aplicativo de processamento
do gerenciamento de alarmes.
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Função Ícone Descrição

Painel de vídeo Mostra quatro telas no campo
da caixa de diálogo para
transmissões de câmeras de
vídeo individuais

Propriedades Abre uma caixa de diálogo para
as configurações gerais do
sistema.

Menu ? (Ajuda)

Tópicos de ajuda Abre este arquivo de ajuda.

Sobre o Access
Professional
Edition -
Personnel
Management

Exibe informações sobre o
Personnel Management.
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2.4.1 Apagar pessoas
Se quiser remover algumas pessoas que não são mais necessárias no sistema, selecione
Cleanup persons (Apagar pessoas) no menu Persons (Pessoas)

Um certo número de pessoas serão listadas. É possível selecioná-las com base em vários
critérios de filtragem. As pessoas que tiverem direitos de usuários existentes não serão
exibidas. O exemplo abaixo refere-se a pessoas sem nenhum cartão atribuído.
– Selecione as pessoas que serão removidas.
– Clique no botão Delete selected persons (Excluir as pessoas selecionadas), na parte

inferior
– Clique no símbolo de pesquisa para atualizar a seleção.

2.5 Configuração de Cadastramento
Personnel Management > Tools (Ferramentas) > Properties (Propriedades) abre uma caixa
de diálogo na qual é possível executar tarefas de configuração básicas (ativar, modificar) a
partir de qualquer estação de trabalho.
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– Os locais de trabalho administrativos onde os cartões são atribuídos às pessoas podem
ser equipados com um leitor de cadastramento. Isso deve ser parametrizado e
configurado de acordo com as especificações do fabricante ou com as especificações
fornecidas com o dispositivo. Se um leitor de cadastramento for configurado, a
verificação manual de cartões de identificação será desativada.

As configurações necessárias para os leitores suportados são:

Nome do leitor BAUD D P S

DELTA 1200 Prox RS232 9600 8 N 1

DELTA 1200 iClass RS232 57600 8 E 1

DELTA 1200 USB Hitag, Legic, Mifare 9600 8 N 1

DELTA 1200 RS232 Hitag, Legic, Mifare 19200 8 N 1

Rosslare ARD-1200EM USB 9600 8 N 1

LECTUS secure 5000 MD 9600 8 N 1

D = Bits de dados N = nenhum

P = Paridade E = even

S = Stop bits O = odd

Aviso!
O Delta 1200 Series e o Rosslare ARD-1200EM Series não foram avaliados por UL.
Consequências

– Sistema de cartões com chip
Exibe a tecnologia de cartões — MIFARE classic e Hitag1 podem ser usadas para Access
PE.
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– Se o sistema tiver sido instalado com o módulo opcional Card Personalization (CP), a
respectiva caixa de verificação estará selecionada nas configurações. Ao remover a
seleção dessa caixa, todas as funções de design/criação de cartões serão bloqueadas.

– Além disso, a transferência automática de dados de funcionários por meio da Conexão
com o LAC Server também será selecionada. Esta caixa deve permanecer sempre
selecionada.

– A exibição de informações do cartão durante sua atribuição pode ser desativada aqui.
Esta exibição só é necessária quando, contrariamente às configurações predefinidas (ver
Configurações Gerais no Access PE - Configurator), forem necessários dados do cartão
que não estejam em conformidade com as configurações padrão da empresa.

– Clique na caixa de seleção Ativar fontes THAI para relatório, se forem necessários
relatórios nas fontes e no idioma tailandeses. OBSERVAÇÃO: isso funciona apenas na
dimensão da língua inglesa.

2.5.1 Cadastramento através de leitores AMC conectados
Certifique-se de que pelo menos um leitor está configurado com um Door Model 06c (Modelo
de porta 06c), que é o modelo de porta para cadastramento.
– Inicie o Configurator e selecione um Controlador de Acesso Local (LAC) (por exemplo,

AMC2 Wiegand).
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Clique no símbolo de Entradas e adicione um novo leitor de entrada:

A janela da caixa de diálogo Entrances (Entradas) é aberta:
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Nessa caixa de diálogo:
– Insira uma descrição (por exemplo, leitor de cadastramento AMC)
– Selecione um LAC e um ID do grupo (GID)
– Selecione um tipo de leitor (por exemplo, Wiegand)
– Selecione um número entre 1 e 8 como o endereço do leitor de acesso
Clique em OK para confirmar a configuração de cadastramento.

Para atribuir o leitor de cadastramento configurado a uma estação de trabalho específica,
você terá que mudar para o cliente APE.
– Selecione Tool (Ferramenta) > Properties (Propriedades).

Selecione um leitor de cadastramento disponível para ativar o processo de cadastramento.
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Confirme se o leitor de cadastramento está on-line.
Se você não receber uma resposta imediata, reinicie a janela de diálogo Personnel
Management (Gerenciamento de pessoal).
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3 Personnel Management (Gerenciamento de pessoas)
Essa caixa de diálogo é o aplicativo principal das estações de trabalho. Juntamente com os
recursos de armazenamento e de edição de dados, ela também apresenta as localizações de
cada pessoa, assim como alguns bloqueios que lhes tenham sido atribuídos. Também é
possível executar processos de monitoramento do sistema por meio das funções de controle
da porta e de exibições do estado do dispositivo.

3.1 Lista de pessoas
A lista de pessoas contém todas as pessoas reconhecidas pelo sistema. Por predefinição, aqui
são listados o primeiro nome e a empresa ou departamento. Uma coluna de símbolos
separada fornece mais detalhes sobre o estado da pessoa ou do cartão como segue:

A pessoa não tem um cartão

A pessoa está ausente

A pessoa está presente

A pessoa está ausente e bloqueada. Além disso, a
caixa de diálogo mostra uma luz intermitente.

A pessoa está presente e bloqueada. Além disso,
a caixa de diálogo mostra uma luz intermitente.

A visualização da lista predefinida com as colunas Symbol (Símbolo), Name (Nome),
Company/Dept (Empresa/Depto) pode ser customizada para cada estação de trabalho. O
menu View > Personnel Data (Ver > Dados pessoais) pode ser usado para adicionar ou
remover mais colunas. As colunas exibidas estão marcadas e, se forem selecionadas
novamente, alterna-se entre as opções ativada e desativada.
Estão disponíveis as seguintes colunas adicionais:
– Nº do cartão
– Nº de matrícula
– Empresa/Depto.
– Grupo de funcionários
– Telefone
– Localização (se Áreas tiverem sido definidas)
– Imagem
– Último acesso
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Aviso!
A largura atual da caixa de listagem pode não permitir que sejam exibidas todas as colunas
selecionadas. Neste caso, ajuste a largura e a ordem da caixa e colunas para melhor adequar
as suas necessidades. A ordem das colunas pode ser alterada arrastando e soltando os
cabeçalhos das colunas. O aumento da largura da lista de pessoas tem impacto na largura da
caixa de diálogo para a direita.

A barra de ferramentas contém uma caixa de seleção para filtrar a lista de pessoas. Por
predefinição todas as pessoas são exibidas em Funcionários ou Visitantes.

Observação: se você adicionar um grupo adicional (por exemplo, VIPs), os membros desse
grupo serão listados automaticamente em Funcionários.
Você pode adicionar a coluna de Imagem à Lista de funcionários. Você pode ocultar ou
mostrar a coluna pelo menu Exibir > Dados de funcionários > Imagem.
Uma vez que esta coluna é adicionada à margem direita, poderá ser necessário, por vezes,
percorrer toda a lista de Pessoas para a tornar visível. Poderá ser necessário ocultar outras
colunas.

Aviso!
As imagens ajustam-se à altura da coluna, por isso poderá ser difícil identificar as pessoas se
o visor for pequeno. O principal motivo para a apresentação das imagens é, portanto, permitir
que os usuários verifiquem rapidamente quais as pessoas ainda não têm uma foto
armazenada.
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3.2 Caixa de diálogo para dados pessoais
Se você selecionar uma entrada na lista de pessoas, os dados dessa pessoa serão exibidos no
campo da caixa de diálogo à direita.

Além de exibir os dados pessoais mais importantes, podem ser acessadas várias funções a
partir dessa caixa de diálogo.

Exibição/Função Descrição

Nome
(Título - Primeiro nome
- Sobrenome)

Exibir apenas - as modificações
podem ser feitas utilizando a caixa
de diálogo de modificação - Dados
pessoais e do cartão, página 34.

Company/Dept.
(Empresa/Depto.)

Personnel-No. (Nº de
matrícula)

Card-No. (Nº do cartão)

Foto

Current Status (Estado
atual)

Exibição de ausência / presença
incluindo a data.

Set present, Set absent
(Definir presente,
definir ausente)

Dependendo do estado atual, a
pessoa pode ser definida aqui como
estando presente ou ausente.

Notas Espaço para notas de texto livres
sobre esta pessoa. Máx. 50
caracteres.
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Exibição/Função Descrição

Memo (Memorando) Espaço para notas de texto livres
sobre esta pessoa. Máx. 300
caracteres.

Memo preview/ Print
Memo (Pré-visualizar/
Imprimir memorando)

O texto de memorando pode ser
visualizado ou impresso de acordo
com um layout de impressão
predefinido.

Telephone (Telefone) Número de telefone ou
acessibilidade desta pessoa.

Localização Exibição e modificação da
localização da pessoa. Pode ser
selecionada qualquer área, bem
como o valor predefinido --
unknown -- (-- desconhecida --).

Special messages on
the reader (Mensagens
especiais no leitor)

cada linha do visor pode conter um
máximo de 20 caracteres

Nome O nome da pessoa tal como exibido
pelos leitores devidamente
equipados.

On arrival (Na chegada) Texto especial de boas-vindas.

On leaving (Na partida) Texto especial de despedida.

Estado do cartão

– valid (válido)
– explicitly blocked

(explicitamente
bloqueado)

– 3x wrong PIN input
(3x introdução do
PIN errado)

– Selected for
random screening
(selecionado para
revista aleatória)

Exibição e modificação do estado
do cartão. Os seguintes parâmetros
do cartão podem ser aqui definidos.

3.3 Estado do dispositivo
A terceira área na caixa de diálogo principal de gerenciamento de funcionários, situada abaixo
da lista de pessoas, é a exibição do status do dispositivo.
A exibição do estado do dispositivo está situada próximo à lista de mensagens do histórico.
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Os seguintes símbolos refletem o status do dispositivo:

Status do dispositivo Símbolo

O controlador está online

O controlador está offline

A conexão ao controlador não pode ser
determinada

Conexão ao leitor - OK

Falha na conexão ao leitor

A conexão ao leitor não pode ser
determinada.

Modo de operação/
Status da porta

Símbolo para 
normal

Símbolo para
aberta
permanentemente

Símbolo para
bloqueada
permanentemente

Fechado

Aberta normal N/D

Tempo de abertura
expirado

N/D N/D

Abertura interrompida N/D

Desconhecido

Com defeito

As falhas de conexão são marcadas adicionalmente por uma barra no limite inferior da caixa
de diálogo, piscando em vermelho no início da caixa de diálogo.
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Aviso!
A exibição do estado dos leitores Wiegand pode ser incorreta. Uma vez que não têm
capacidade para responder a um questionamento de seu estado, um leitor Wiegand
parametrizado é apresentado como online durante o tempo que o seu controlador se
encontrar online.

Controles
Esta função está ativa somente quando o usuário conectado tem direitos de controle da porta
- Direitos de usuário, página 62.
Esta função está ativa somente quando o usuário conectado tem direitos de controle da
porta.
Às entradas selecionadas na lista do estado do dispositivo, às quais existe uma conexão,
podem ser fornecidos comandos pelo menu de contexto (clicar com o botão direito) ou do
menu Door management (Gerenciamento de porta)

O nome da entrada selecionada é lido a partir do contexto.

Abrir <Entrada> A entrada selecionada abre uma
vez (para uma pessoa).

aberta durante muito tempo -
Modo de porta aberta
<Entrada>

A entrada selecionada abre por
um período maior de tempo.

Travar <Entrada> A entrada selecionada é
travada.
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3.4 Histórico de acesso online
 O menu de contexto das entradas na lista de estados do dispositivo oferece também a função
Online swipe (Histórico online), que abre um painel do lado direito do campo da caixa de
diálogo.
Nesta área, a função exibe um histórico de registros e de mensagens para a entrada
selecionada. São listadas as últimas pessoas que passaram os respectivos cartões em um dos
leitores desta entrada, junto com as suas imagens de arquivo, um carimbo de data/hora, assim
como a decisão do sistema relativa ao acesso.
Adicionalmente, quaisquer mensagens não pertencentes às categorias Mensagem ou
Informação (exceto os números de mensagem 61 a 67) são aqui exibidas, marcadas com o

símbolo .
A entrada em questão é exibida no topo do painel. Mesmo após a seleção de uma entrada
diferente na lista de estados do dispositivo, a visualização do histórico de acessos online para
a primeira entrada permanece visível. Para mudar a visualização do histórico de acessos online
para outra entrada, deve chamá-la explicitamente pelo menu de contexto para essa entrada
Enquanto estiver ativo, o menu de contexto contém a linha desligar histórico de acessos
online, para que o histórico de acessos possa ser ocultado novamente em qualquer momento.
As notas realçadas com cor indicam se o acesso foi liberado (verde) ou negado (vermelho).

São mostradas somente as últimas 5 mensagens e/ou registros.
Enquanto a visualização do histórico de acessos online está ativa, a exibição vai sendo
constantemente atualizada com novas mensagens, com as mais recentes aparecendo no topo.
A lista contém apenas pedidos de acesso para o dia atual e para o anterior. Se nenhum cartão
for lido durante esse período, a lista permanecerá em branco.

3.5 Gerenciamento de Vídeo
Os componentes de vídeo integrados ao sistema de controle de acesso Access Professional
Edition podem ser utilizados como ferramenta de controle adicional em entradas especiais
para comparar imagens ao vivo com imagens armazenadas em um banco de dados e verificar a
área ao redor. Também é possível gerar respostas de alarme especiais usando gravações de
vídeo e monitorar áreas específicas, mesmo independentes das entradas.
Além disso, componentes de vídeo podem ser acessados e usados no Access PE nas áreas a
seguir.
– Verificação por vídeo: controles ópticos adicionais nas entradas
– Gerenciamento de alarmes: mensagens de alarme e entradas especialmente configuradas

podem ser aceitas por sequências de vídeo gravadas
– Exibições de vídeo: reprodução das imagens de vídeo atuais provenientes de até quatro

câmeras de configuração livre, ao mesmo tempo
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Veja também
– Painel de vídeo, página 27
– Imagem ao vivo, página 28

3.5.1 Painel de vídeo

Pressione o botão  na barra de ferramentas do Gerenciamento de funcionários para
substituir o campo da caixa de diálogo por uma tela exibindo quatro vídeos.

No painel de vídeo é possível selecionar até quatro câmeras de diferentes entradas.
As funções a seguir estão disponíveis para cada uma das janelas de exibição.

Lista de seleções Você pode selecionar qualquer câmera
carregada no sistema de controle de acesso
e substituí-la a qualquer momento.

Armazena uma imagem fixa da exibição atual
como <nome do
dispositivo>_aaaaMMddhhmmsstttt.jpg em
C:\BOSCH\Access Professional Edition\PE
\Data\Video (caminho padrão).

Inicia/Encerra uma gravação de vídeo da
exibição atual e a armazena como <nome do
dispositivo>_aaaaMMddhhmmsstttt.vxx em
C:\BOSCH\Access Professional Edition\PE
\Data\Video (caminho padrão).
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(= Ponto de interesse) Cria uma imagem fixa
da exibição atual — POI_ é adicionado no
início do nome do arquivo.
Uma mensagem também é criada no
histórico de eventos como um marcador.

Personalizar visualizações para a exibição de vídeo
Uma seleção e uma ordem específicas de câmeras podem ser salvas e chamadas
posteriormente pelo nome. Isso economiza tempo, que, caso contrário, seria desperdiçado ao
selecionar e configurar manualmente a mesma exibição.
Primeiro, configure manualmente a exibição desejada ao posicionar as câmeras nas
respectivas janelas segundo suas necessidades.
Em seguida, atribua à exibição um nome significativo ao editar a caixa de combinação inferior
e salve-a ao pressionar ENTER. Essas exibições poderão ser, posteriormente, chamadas pelo
nome a partir da mesma caixa de combinação.
Desse modo, os operadores podem salvar diferentes exibições de câmera para diferentes
finalidades, por exemplo, monitorar a entrada de funcionários de manhã e a saída de
funcionários à noite. As exibições salvas pertencem à estação de trabalho e não ao operador
individual. Como tal, elas não podem ser editadas. Para alterar uma exibição, primeiro,
selecione-a na caixa de combinação, exclua seu nome ao usar o botão

 à direita da caixa de combinação, modifique o posicionamento da câmera conforme o
necessário e, em seguida, salve-a com o mesmo nome utilizado antes de pressionar ENTER.
As exibições salvas são específicas à estação de trabalho e não ao operador. Isso permite aos
operadores usar exibições personalizadas pelos seus colegas.

3.5.2 Imagem ao vivo
Além das funções de controle de porta, o menu pop-up, que exibe entradas e leitores na lista
de estados de dispositivo, também contém entradas para conectar imagens ao vivo.

Aviso!
Essas funções não estão disponíveis na lista de estados de dispositivos no Visualizador de
histórico.

Há uma entrada geral para todas as câmeras configuradas e atribuídas a esta entrada. Se o
número máximo de câmeras tiver sido configurado, o menu pop-up para o modo de imagens
ao vivo será exibido como:
– Câmera de identificação
– Câmera traseira 1
– Câmera traseira 2
– Câmera frontal 1
– Câmera frontal 2

Ao selecionar uma câmera, a imagem ao vivo será exibida na tela. Se você não tiver
selecionado um registro pessoal, a imagem ao vivo será exibida no campo da caixa de diálogo
(em vez da hora); caso contrário, ela será exibida em um formato menor à direita da lista de
estados do dispositivo.
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Se você selecionar um registro de pessoal para edição enquanto a grande imagem ao vivo
estiver sendo exibida, o modo de imagem ao vivo será alternado para um formato menor.
Se a função de imagem ao vivo para uma das câmeras estiver ativa, o menu pop-up incluirá a
entrada Vídeo desativado, que poderá ser usada para restaurar o estado padrão.

Aviso!
Também é possível ativar o modo de imagens ao vivo através da lista de câmeras na guia
Dispositivos de vídeo ao selecionar a entrada necessária.

3.6 Gerenciamento de Vídeo
Os componentes de vídeo integrados ao sistema de controle de acesso Access Professional
Edition podem ser utilizados como ferramenta de controle adicional em entradas especiais
para comparar imagens ao vivo com imagens armazenadas em um banco de dados e verificar a
área ao redor. Também é possível gerar respostas de alarme especiais usando gravações de
vídeo e monitorar áreas específicas, mesmo independentes das entradas.
Além disso, componentes de vídeo podem ser acessados e usados no Access PE nas áreas a
seguir.
– Verificação por vídeo: controles ópticos adicionais nas entradas
– Gerenciamento de alarmes: mensagens de alarme e entradas especialmente configuradas

podem ser aceitas por sequências de vídeo gravadas
– Exibições de vídeo: reprodução das imagens de vídeo atuais provenientes de até quatro

câmeras de configuração livre, ao mesmo tempo

Veja também
– Painel de vídeo, página 29
– Imagem ao vivo, página 31

3.6.1 Painel de vídeo

Pressione o botão  na barra de ferramentas do Gerenciamento de funcionários para
substituir o campo da caixa de diálogo por uma tela exibindo quatro vídeos.
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No painel de vídeo é possível selecionar até quatro câmeras de diferentes entradas.
As funções a seguir estão disponíveis para cada uma das janelas de exibição.

Lista de seleções Você pode selecionar qualquer câmera
carregada no sistema de controle de acesso
e substituí-la a qualquer momento.

Armazena uma imagem fixa da exibição atual
como <nome do
dispositivo>_aaaaMMddhhmmsstttt.jpg em
C:\BOSCH\Access Professional Edition\PE
\Data\Video (caminho padrão).

Inicia/Encerra uma gravação de vídeo da
exibição atual e a armazena como <nome do
dispositivo>_aaaaMMddhhmmsstttt.vxx em
C:\BOSCH\Access Professional Edition\PE
\Data\Video (caminho padrão).

(= Ponto de interesse) Cria uma imagem fixa
da exibição atual — POI_ é adicionado no
início do nome do arquivo.
Uma mensagem também é criada no
histórico de eventos como um marcador.

Personalizar visualizações para a exibição de vídeo
Uma seleção e uma ordem específicas de câmeras podem ser salvas e chamadas
posteriormente pelo nome. Isso economiza tempo, que, caso contrário, seria desperdiçado ao
selecionar e configurar manualmente a mesma exibição.
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Primeiro, configure manualmente a exibição desejada ao posicionar as câmeras nas
respectivas janelas segundo suas necessidades.
Em seguida, atribua à exibição um nome significativo ao editar a caixa de combinação inferior
e salve-a ao pressionar ENTER. Essas exibições poderão ser, posteriormente, chamadas pelo
nome a partir da mesma caixa de combinação.
Desse modo, os operadores podem salvar diferentes exibições de câmera para diferentes
finalidades, por exemplo, monitorar a entrada de funcionários de manhã e a saída de
funcionários à noite. As exibições salvas pertencem à estação de trabalho e não ao operador
individual. Como tal, elas não podem ser editadas. Para alterar uma exibição, primeiro,
selecione-a na caixa de combinação, exclua seu nome ao usar o botão

 à direita da caixa de combinação, modifique o posicionamento da câmera conforme o
necessário e, em seguida, salve-a com o mesmo nome utilizado antes de pressionar ENTER.
As exibições salvas são específicas à estação de trabalho e não ao operador. Isso permite aos
operadores usar exibições personalizadas pelos seus colegas.

3.6.2 Imagem ao vivo
Além das funções de controle de porta, o menu pop-up, que exibe entradas e leitores na lista
de estados de dispositivo, também contém entradas para conectar imagens ao vivo.

Aviso!
Essas funções não estão disponíveis na lista de estados de dispositivos no Visualizador de
histórico.

Há uma entrada geral para todas as câmeras configuradas e atribuídas a esta entrada. Se o
número máximo de câmeras tiver sido configurado, o menu pop-up para o modo de imagens
ao vivo será exibido como:
– Câmera de identificação
– Câmera traseira 1
– Câmera traseira 2
– Câmera frontal 1
– Câmera frontal 2

Ao selecionar uma câmera, a imagem ao vivo será exibida na tela. Se você não tiver
selecionado um registro pessoal, a imagem ao vivo será exibida no campo da caixa de diálogo
(em vez da hora); caso contrário, ela será exibida em um formato menor à direita da lista de
estados do dispositivo.

Se você selecionar um registro de pessoal para edição enquanto a grande imagem ao vivo
estiver sendo exibida, o modo de imagem ao vivo será alternado para um formato menor.
Se a função de imagem ao vivo para uma das câmeras estiver ativa, o menu pop-up incluirá a
entrada Vídeo desativado, que poderá ser usada para restaurar o estado padrão.
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Aviso!
Também é possível ativar o modo de imagens ao vivo através da lista de câmeras na guia
Dispositivos de vídeo ao selecionar a entrada necessária.
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4 Dados de funcionários

Para criar uma nova pessoa, abra uma caixa de diálogo vazia usando o botão  ou pelo
menu Pessoas > Nova pessoa

Aviso!
Note que isto se refere à criação de um novo registro pessoal. Se, em vez disso, você deseja
editar dados pessoais existentes, clique duas vezes em alguém na lista de pessoas ou

selecione-o e clique no botão  na barra de ferramentas. Será aberta a mesma caixa de
diálogo, mas contendo os dados da pessoa selecionada.
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4.1 Dados pessoais e do cartão
A caixa de diálogo de dados e autorizações pessoais contém todos os dados pessoais e do
cartão relevantes, bem como informações especiais do cartão. O dados mínimos para que a
pessoa possa ser gravada no banco de dados são o nome e um grupo de pessoas.
Podem ser armazenadas as seguintes informações:

Campo de
dados/
Campo de
entrada

Descrição

Pessoa

Cargo Estes dados aparecem aqui pela ordem
Cargo, Nome, Sobrenome. Na lista de
pessoas, o cargo não é exibido.

Sobrenome

Nome

Data de
nascimento

A data pode ser inserida em números ou
selecionada com o botão de rotação (setas
para cima/para baixo).

Empresa A empresa ou departamento pode ocupar 4
linhas. Para inserir quebras de linha, use
Ctrl + ENTER. Máx. 114 caracteres.

Telefone Também aparece como informação a
disponibilidade da pessoa. Máx. 30
caracteres.

Válido de ...
até ...

O período de validade para controle de
acesso pode ser especificado aqui. Campos
vazios sugerem validade ilimitada.

Grupo de
funcionários

Entrada obrigatória. Um grupo de pessoas
deve ser selecionado.

Dados do cartão

(Exibição do
status do
cartão)

Exibição simbólica do status atual do
cartão.

 Nenhum cartão atribuído

 Cartão atribuído

Nº de matrícula Insira um número de matrícula de até 6
dígitos

1. Nº do cartão Insira um número de cartão de até 6 dígitos
Todos os cartões recebem as mesmas
autorizações de acesso.

2. Nº do cartão

3. Nº do cartão
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Campo de
dados/
Campo de
entrada

Descrição

Função especial

Permissão para
abertura de
longo prazo das
portas (modo
Escritório)

Conceder autorização para usar o modo
Escritório nas respectivas portas
configuradas (veja o manual de
configuração).

Ativar função
de controle 1

A função de controle 1 será acionada no
respectivo leitor configurado.

Ativar função
de controle 2

A função de controle 2 será acionada no
respectivo leitor configurado.

Mensagens especiais no leitor

Nome de
apresentação

Exibição de texto para leitores de cartão
compatíveis. O padrão é: Nome,
Sobrenome. Máx. 20 caracteres.

Texto na
entrada

Os textos de visualização personalizados
para chegada e saída podem ser
introduzidos aqui para leitores de
apontamento de frequência. O pré-requisito
é que o parâmetro do sistema Show
welcome/leaving message (Mostrar
mensagem de boas-vindas/despedida)
esteja ativado nas configurações do
Configurator. Máx. 20 caracteres.

Texto na saída

Dados de controle de acesso

Modelo de
tempo

Selecione um modelo obrigatório existente.
A pessoa tem permissão de acesso apenas
durante os períodos definidos.

PIN Entrada de PINs para utilização de leitores
com o teclado. Os PINs não podem ser
sequências (por ex., 1234) nem
palíndromos (por exemplo, 0110). As
configurações gerais para os PINs são
efetuadas na caixa de diálogo Configurator
> Settings (Configurações).
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Campo de
dados/
Campo de
entrada

Descrição

Verificação +
PIN de
confirmação

Esse PIN pode ser gerado:
– automaticamente pelo sistema ou
– inserido como um PIN de 4 a 8 dígitos

(predefinição = 4); como medida de
segurança adicional, ele será solicitado
após a apresentação do cartão em uma
entrada.

PIN de
identificação/
PIN ID

Como esse PIN precisa ser único em todo o
sistema, ele pode ser gerado:
– automaticamente pelo sistema ou
– inserido como um PIN de 4 a 8 dígitos

(predefinição = 4); como medida de
segurança adicional, ele será solicitado
após a apresentação do cartão em uma
entrada.

O PIN ID é exibido em um caixa de diálogo
de mensagem antes de ser salvo.

Esse PIN de identificação pode ser inserido
nos leitores com teclados em vez da
apresentação de um cartão. Como esse PIN
funciona virtualmente como um número de
cartão, ele também inclui todas as
autorizações atribuídas a esse número.
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Campo de
dados/
Campo de
entrada

Descrição

PIN de
armação/PIN
de IDS

Inserção de um PIN de 4 a 8 dígitos
(predefinição = 4, o mesmo tamanho de um
PIN de verificação) para armar o sistema de
alarme.
A caixa de verificação PIN de IDS separado
[Configurator > Settings (Configurações]
permite determinar se estes campos serão
ou não exibidos.
Por padrão, os campos de armar/desarmar
o IDS (Sistema de Detecção de Intrusão)
não serão exibidos.
Se um PIN de armação separado não for
definido, um PIN de verificação poderá ser
usado para armar o IDS. No entanto, se um
PIN de armação separado tiver sido
definido, ele poderá ser usado
independentemente - nesse caso, o PIN de
verificação não funcionará como um PIN de
armação.

Observação: existe uma quarta variedade de PIN, o PIN de
porta, que pode ser atribuído a portas individuais. Esse
código deve ser do conhecimento de todos que utilizam a
porta.
Os PINs de porta são definidos e ativados no Configurador
da página Entrances (Entradas), por meio da função PIN or
Card (PIN ou Cartão).

Importante: ao utilizar controladores e leitores Wiegand, é
necessário ativar a opção PIN or Card (PIN ou Cartão) para a
definição do cartão Wiegand (Nº 6) para utilizar os PINs de
identificação, desarme ou porta.

Botões do lado direito da caixa de diálogo

Tirar fotografia Estes botões ficam visíveis somente quando
o aplicativo Card Personalization (CP)
(Criar cartões, página 45) está instalado e
em execução na estação de trabalho em
questão.

Pré-visualizar
cartão

Imprimir cartão

Imprimir o
verso do cartão

Reconheciment
o
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Campo de
dados/
Campo de
entrada

Descrição

Importar
fotografia

Podem ser importadas fotografias nos
formatos .jpg ou .bmp. A fotografia é
integrada à exibição dos dados pessoais.

Excluir
fotografia

Apenas ativada se uma fotografia tiver sido
importada.

Excluir cartão 1 Ativado apenas se um cartão tiver sido
atribuído; altera a exibição do status do
cartão (veja acima).

Excluir cartão 2

Excluir cartão 3

Atribuir cartão
1

Atribui um número de cartão à pessoa
selecionada e altera a exibição do status do
cartão (veja acima).

Atribuir cartão
2

Atribuir cartão
3

Aviso!
As variantes de PIN de porta e de identificação não podem ser usadas para modelos de porta
com ativação do sistema de intrusão (MP 10 e 14).

4.2 Atribuir e cancelar cartões
Cada usuário de cartão pode ter até três cartões, cujas atribuições e cancelamentos podem
ser feitos separadamente. Dependendo da configuração do sistema, os dados do cartão
podem ser registrados manualmente ou por meio de um leitor de cadastramento, mas esses
dois métodos não podem estar ativos simultaneamente: quando um leitor de cadastramento é
configurado (Tools > Properties (Ferramentas > Propriedades)), os métodos manuais não
podem mais ser utilizados em paralelo.
O registro manual de dados suporta o uso de diferentes tecnologias de cartões permitindo ao
operador alterar formatos de bits de cartões subjacentes. No entanto, ao utilizar um leitor de
cadastramento, só é possível utilizar cartões com a mesma tecnologia subjacente.

Aviso!
No Access PE, um usuário de cartão pode utilizar múltiplas credenciais com múltiplos
formatos e tecnologia. No entanto, cada um destes identifica o mesmo indivíduo com o
mesmo conjunto de autorizações, bloqueios, PINs, modelos de tempo e restrições de área.

Dependendo das Properties (Propriedades) (Configuração de Cadastramento, página 14), os
cartões podem ser verificados manualmente ou com um leitor. Somente pode estar ativo um
destes modos de cada vez. Assim que o leitor for configurado, o número do cartão deixa de
poder ser verificado manualmente.
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Verificação manual do cartão
Para a verificação manual do cartão, deve ser definido um número do cartão com um máximo
de seis dígitos por predefinição, além dos dados pessoais mínimos como o Nome e Grupo de
Pessoas. Insira um nº de cartão válido para a pessoa!
Clicando em Assign card (Atribuir cartão), tem início uma verificação de que este número do
cartão é único. Este cartão já está atribuído à seguinte pessoa: xxx
O número do cartão de identificação é agora codificado com base nos dados do cartão
predefinido mostrados na caixa de diálogo Settings (Configurações) do Access PE
Configurator. Uma atribuição bem-sucedida é assinalada por uma caixa de diálogo que deve
ser confirmada com OK antes que os dados sejam salvos.

Se Connect to LAC Service (Conectar ao LAC Service) estiver ativado nas propriedades do
Personnel Management (Gerenciamento de pessoas) (Configuração de Cadastramento, página
14), as alterações ou acréscimos dos dados pessoais serão transmitidos imediatamente ao
LAC service e se tornarão válidos em todo o sistema.

Aviso!
A uma pessoa deve ser atribuído não apenas um número de cartão, mas também as
autorizações (Autorizações, página 40) necessárias para todas as entradas.
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Se a caixa de verificação Do not show dialog for editing card information (Não mostrar a
caixa de diálogo para editar informação do cartão) não for selecionada nas propriedades do
Personnel Management (Gerenciamento de pessoas), então o botão Assign card (Atribuir
cartão) chamará a seguinte caixa de diálogo, que permitirá substituir as configurações
predefinidas (ver Access PE Configurator).

Verificação do cartão pelo leitor de cadastramento.
Um leitor de cadastramento conectado para verificar cartões deve estar configurado nas
propriedades do Personnel Management (Gerenciamento de pessoas). A verificação manual
é assim automaticamente desativada.
Neste caso, todos os dados são lidos a partir do cartão. Assim, uma entrada com chave é
desnecessária e será ignorada pelo sistema.
É solicitado ao usuário que mantenha o seu cartão sobre o leitor de cadastramento, do qual
receberá permissão para entrar ou uma mensagem de erro.

4.3 Autorizações
Esta página só é mostrada quando o usuário atualmente conectado tem direitos de
administrador (Direitos de usuário, página 62) para modificar as autorizações.
Esta aba serve para atribuir autorizações a pessoas no sistema de controle de acesso. Se o
Configurator (Configurador) (caixa de diálogo Authorization groups (Grupos de autorização))
já tiver sido utilizado para atribuir autorizações predefinidas a determinados grupos de
pessoas, então a pessoa terá recebido essas autorizações por meio da atribuição a esse grupo
de pessoas.

As autorizações do usuário podem, no entanto, ser completadas com esta aba.
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Esta caixa de diálogo contém quatro caixas de listagem. As caixas à direita listam todos os
grupos de autorização configurados (lista superior) e todas as entradas individuais
configuradas (lista inferior). As autorizações totais de uma pessoa consistem em todos os
grupos de autorização e todas as entradas individuais atribuídas nesta caixa de diálogo.
As autorizações (grupos ou entradas) podem ser transferidas para uma pessoa fazendo duplo

clique na caixa de listagem à direita ou selecionando uma e clicando em . O botão 
transfere todas as autorizações disponíveis de uma vez. Pode ser atribuída qualquer
combinação de autorizações de grupo ou individuais. De forma inversa, as autorizações

atribuídas podem ser canceladas com clique duplo ou utilizando os botões  e .
Se os grupos de autorização possuírem modelos de tempo (estes devem ser nomeados de
forma adequada), as entradas atribuídas ao grupo somente podem ser acessadas por essa
pessoa durante esses modelos de tempo. Tenha em atenção os casos especiais em
Application of time models (Aplicação de modelos de tempo) *** XRef ME TO
Anwendung_von_Zeitmodellen.xml no Access PE.
Por predefinição, as autorizações não estão limitadas por tempo, no entanto, é possível limitar
as autorizações individuais e de grupo introduzindo datas nas colunas valid from (Válido de) e
valid to (Válido até). Clicar em uma célula dessas colunas abrirá um editor em linha para

introduzir datas e horas: 
As datas podem ser introduzidas pelo teclado ou mouse utilizando os controles do tipo setas
pequenas no lado direito do editor. A barra de espaços move o cursor do dia para mês para
ano etc. Além disso, ao clicar com o botão direito em um campo de data aberto, o usuário
pode acessar um calendário para selecionar datas com maior rapidez e conforto.
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Desta forma, ao criar uma pessoa, as autorizações podem ser atribuídas de forma a serem
ativadas apenas em uma data posterior. Assim, não é necessário configurar um lembrete para
reeditar as autorizações da pessoa, uma vez que essas autorizações podem ser configuradas
para expirar automaticamente em uma determinada data. Se uma data da coluna valid from
(válido de) ocorrer depois de uma data da coluna valid to (válido até), a autorização será
desativada assim que a data valid to (válido até) for alcançada e reativada ao alcançar a data
valid from (válido de). Essa função pode ser útil, por exemplo, quando uma pessoa tira férias.
Alterações em autorizações e em outros dados pessoais não serão salvas até serem
confirmadas clicando em OK. Em seguida, todas as alterações serão transmitidas
automaticamente aos controladores, desde que em configurações (Tools > Properties)
(Ferramentas > Propriedades) a opção Connect to LAC Service (Conectar ao LAC Service)
esteja ativada. Em casos especiais, os dados podem ser transmitidos explicitamente utilizando
os menus Persons > Transmit selected person to LAC service (Pessoas > Transmitir pessoa
selecionada ao LAC service) ou Persons > Transmit all persons to LAC service (Pessoas >
Transmitir todas as pessoas ao LAC service).

4.4 Campos adicionais
Esta aba somente fica visível quando, pelo menos um dos dez campos de dados adicionais
disponíveis é configurado no Access PE Configurator.
Até dez campos de dados adicionais podem ser configurados. Estes podem variar em número
e nome de campo. Os campos podem conter valores até 40 caracteres.
Os campos são apresentados por ordem. Se um dos dez campos for ignorado, um espaço será
deixado como marcador de posição. Se esse campo for configurado mais tarde, ele substituirá
o marcador de posição pela ordem.
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!

Cuidado!
A cada campo de introdução de texto é atribuído um campo na base de dados, para que os
dados possam ser armazenados, selecionados e incluídos nos relatórios. No entanto, isso
significa que as alterações a campos de dados adicionais em uso levarão à perda dos dados
contidos no banco de dados. Se o uso do conteúdo nos campos adicionais não mudar, o
nome do campo poderá ser alterado a qualquer momento.

4.5 Aplicação de modelos de tempo
Os modelos de tempo associados a dados pessoais estarão ativos apenas se as configurações
predefinidas do leitor não tiverem sido alteradas e se a opção No time model check (Sem
verificação do modelo de tempo) permanecer desativada.
Os modelos de tempo podem ser usados de várias formas; por isso, para compreender como
o sistema trata de atribuições múltiplas, observe as seguintes regras de resolução de
conflitos:
Se uma pessoa tiver acesso a determinadas entradas por meio de um modelo de tempo e se
ela tiver acesso às mesmas entradas sem um modelo de tempo, a restrição livre prevalecerá.
Ou seja, neste caso o modelo de tempo não será aplicado.
Exemplo:
São concedidos os seguintes direitos de acesso a uma pessoa:
– Acesso às entradas A, B, C e D dentro de um modelo de tempo das 09:00 às 17:00 todos

os dias.
– Direitos de acesso individuais para as entradas B e D sem modelo de tempo.
Agora, essa pessoa tem acesso às entradas A e C das 09:00 às 17:00 todos os dias e acesso
sem restrições às entradas B e D.
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– Se uma pessoa receber direitos de acesso diferentes abrangendo as mesmas entradas,
mas controlados por modelos de tempo diferentes, a união dos modelos de tempo será
aplicada.

Exemplo:
São concedidos os seguintes direitos de acesso a uma pessoa:
– Acesso às entradas A, B, C e D dentro de um modelo de tempo das 07:00 às 13:00 todos

os dias.
– Acesso às entradas B, D, E e F dentro de um modelo de tempo das 09:00 às 17:00 todos

os dias.
Agora, a pessoa tem acesso às entradas A e C das 07:00 às 13:00, às entradas B e D das 07:00
às 17:00 e às entradas E e F das 09:00 às 17:00.
– Se uma pessoa estiver atribuída a um grupo de autorização com modelos de tempo e se

ela receber um modelo de tempo para usar com o seu cartão, a interseção dos períodos
definidos será aplicada.

Exemplo:
São concedidos os seguintes direitos de acesso a uma pessoa:
– Um grupo de autorização com acesso às entradas A, B, C e D e um modelo de tempo das

07:00 às 13:00 todos os dias.
– Um grupo de autorização com acesso às entradas B, D, E e F e um modelo de tempo das

09:00 às 17:00 todos os dias.
– E adicionalmente um modelo de tempo das 11:00 às 19:00 todos os dias
Agora, a pessoa tem acesso às entradas A e C das 11:00 às 13:00 e às entradas B, D, E e F das
11:00 às 17:00.
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5 Criar cartões
O Access PE é fornecido com o seu próprio programa de personalização de cartões. Este
software pode ser instalado nos computadores da sua escolha. Para personalizar cartões,
também será necessário ter o hardware adequado (câmera e impressora); portanto,
recomendamos que você instale esses componentes apenas nos computadores que serão
usados para personalizar os cartões.
A função de importação de imagens (usada, por exemplo, para mostrar imagens na caixa de
diálogo das pessoas) só funcionará em computadores nos quais o programa de personalização
de cartões foi instalado e iniciado.

5.1 Criar cartões
As funções necessárias para criar cartões podem ser executadas em todas as estações de
trabalho nas quais o programa Badge Designer esteja instalado e funcionando. Os botões para
este fim estão na guia Personnel data (Dados de funcionários).

Além disso, a estação de trabalho deve estar conectada aos equipamentos necessários: uma
câmera e uma impressora de cartões.
Para configurar o hardware, selecione o configurador de personalização de cartão.
Parametrize uma câmera ou uma impressora com as entradas na guia Video e Imprimir.
Consulte também a ajuda online desta ferramenta.
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São recomendados os seguintes passos para a criação de cartões:
– Importar ou tirar uma fotografia
– Pré-visualizar cartão (opcional)
– Imprimir o verso do cartão
– Imprimir recibo do cartão (opcional)

5.2 Tirar ou importar fotografias
As fotos de pessoal, que serão impressas nos cartões ou exibidas na caixa de diálogo de
dados do pessoal, podem ser tiradas com uma câmera conectada ou importadas de um
arquivo, se disponível.

Importar fotografias
As fotografias dos funcionários podem ser importadas como arquivos e atribuídas a dados
pessoais.
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Aviso!
A importação de fotografias também está disponível na estação de trabalho onde não está
instalado aplicativo Card Personalization (Personalização de cartões). Contudo, neste caso as
fotografias só podem ser importadas no tamanho original. Os recursos de edição descritos
abaixo não estão disponíveis.

Para importar uma fotografia de um arquivo clique em Import picture (Importar fotografia) e
selecione um arquivo a partir da caixa de diálogo de seleção de arquivos. As definições de
configuração para o programa Card Personalization (Personalização de cartões) definem um
diretório predefinido para arquivos importados; esse é o primeiro diretório aberto pela função
de importação. Apesar disso, qualquer arquivo de foto no sistema pode ser localizado e
selecionado por meio da caixa de diálogo de seleção de arquivos.
Assim que o arquivo seja selecionado, este é mostrado na janela de pré-visualização para
ajudar a encontrar a fotografia correta.

Assim que uma fotografia for selecionada, será exibida uma caixa de diálogo de edição, que
permite cortar e redimensionar a fotografia. A moldura vermelha marca a parte da fotografia
que será armazenada no sistema para essa pessoa.
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A parte selecionada da fotografia pode ser reposicionada na moldura arrastando e soltando
com o botão esquerdo do mouse.

A parte selecionada da fotografia pode também ser aumentada pressionando e segurando o
botão esquerdo do mouse e arrastando. Desta forma, até pequenas partes de fotografias
podem ser usadas para cartões, desde que a resolução da fotografia permita a ampliação.
Clicando em OK, a parte selecionada da fotografia será importada.
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O tamanho da moldura será adaptado ao tamanho da moldura da janela de diálogo e/ou da
moldura da fotografia no layout do cartão definido e, em seguida, pré-visualizado após
confirmar a importação.

Tirar uma fotografia
O aplicativo para criar cartões Card Personalization (CP) (Personalização de cartões) deve ser
configurado para o tipo de câmera conectada à estação de trabalho. Isto é efetuado utilizando
a caixa de diálogo para a configuração da CP. Consulte essa funcionalidade de ajuda do
aplicativo para saber mais sobre as possíveis configurações.
As seguintes capturas de telas foram tiradas do Video for Windows (Vídeo para o Windows) e
não serão as mesmas para todos os tipos de câmeras.
Clique no botão Take picture (Tirar fotografia) para mostrar a seguinte caixa de diálogo:

Se necessário, as configurações atuais da câmera podem ser verificadas e modificadas com o

botão .
Se as configurações e os requisitos coincidirem, a imagem poderá ser congelada com o botão
Freeze (Congelar).
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O modo Live image (Imagem ao vivo) poderá ser reativado a qualquer momento se a imagem
congelada não for satisfatória. Se a fotografia for usada no cartão de identificação e em dados
pessoais, clique em Apply (Aplicar).
É exibida uma outra caixa de diálogo: Crop picture (Cortar imagem). Utilizando uma moldura
de corte, é possível selecionar a parte da fotografia que é para aparecer no cartão.
Para obter mais informações sobre a utilização da moldura de corte, consulte acima a seção
Importar fotografias.

5.3 Pré-visualizar e imprimir cartões
 Os botões Preview card (Pré-visualizar cartão) e Print card reverse side (Imprimir verso do
cartão) só estarão ativos se os layouts do cartão tiverem sido atribuídos ao respectivo grupo
de pessoas no Access PE Configurator (caixa de diálogo: Personnel Groups (Grupos de
pessoas)).

Preview card (Pré-visualizar cartão)
Depois de fotografar, a fotografia é inserida automaticamente na área predefinida do layout do
cartão, onde pode ser pré-visualizada antes de imprimir. O cartão é pré-visualizado na
seguinte caixa de diálogo acessada pelo botão Preview card (Pré-visualizar cartão).

Fecha a caixa de diálogo clicando em OK.

Print card (Imprimir cartão)
Se o layout do cartão for satisfatório, então ele poderá ser impresso na etapa final. O botão
Print card (Imprimir cartão) permite acessar à seguinte caixa de diálogo, que é semelhante à
anterior, com a exceção de que esta possui um comando para imprimir.
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O botão Print (Imprimir) inicia o processo de impressão chamando uma caixa de diálogo para
selecionar a impressora. Se uma impressora padrão já foi definida no Configurator
(Configurador), então a impressão será executada imediatamente.

Print card reverse side (Imprimir verso do cartão)
Se o verso do cartão deve ser impresso, layouts e conteúdos especiais poderão ser definidos
para essa finalidade.
Nota: Antes de executar a impressão do verso, certifique-se de que os cartões cujas partes
frontais já foram impressas estão na parte mais elevada no compartimento de papel da
impressora de cartões de identificação.
Dica: Recomendamos que o verso contenha apenas dados gerais e não pessoais. Neste caso,
é possível imprimir uma determinada quantidade de versos de cartões e guardá-los de reserva,
tornando mais rápida a montagem de cartões completos conforme a necessidade.
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5.4 Imprimir recibos de cartões
 Outro recurso do aplicativo de criação de cartões é a capacidade de imprimir um recibo
padrão. O recibo registra a entrega do cartão, e o usuário do cartão pode receber informações
sobre os dados nele armazenados.
Para usar essa funcionalidade, um modelo deve ser criado e armazenado para o grupo de
pessoas no Access PE Configurator, caixa de diálogo: Personnel Groups (Grupos de pessoas).
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6 Relatórios
Você pode usar as funções de listagem no Access PE para colar os conteúdos do banco de
dados de um modo específico e organizá-los em um formato claro para impressão.
Para filtrar os resultados de modo a que sejam mostrados somente os dados que o usuário
necessita, é possível utilizar layouts pré-configurados que fornecem informações específicas
relativamente a determinados aspectos do controle de acesso (por exemplo, quem tem que
autorizações para que portas).

6.1 Relatórios

O botão  altera a visualização dos dados dos funcionários para uma caixa de diálogo
para criar e visualizar relatórios relevantes ao controle de acesso.

Vários layouts de relatórios e filtros de conteúdo estão disponíveis:
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Layout Filtros disponíveis Descrição

Dados
pessoais

Sobrenome
Nome
Nº da matrícula
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)

Exibe os dados pessoais.
Os dados podem ser
filtrados de acordo com
quaisquer ou com todos os
filtros disponíveis. Múltiplos
filtros funcionam de forma
restritiva (AND lógico).
Por exemplo, é possível
procurar todas as pessoas
cujo nome comece por A e
cujo número do cartão se
encontre na faixa de 900 a
999.
O caractere * pode ser
utilizado como um
caractere universal para
representar qualquer ou
nenhum caractere.

Blocked
Persons
(Pessoas
bloqueadas
)

Sobrenome
Nome
Personnel no. (Nº
de matrícula)
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)

Exibe dados de pessoas
cujo estado do cartão é
diferente de válido (por ex.,
explicitamente bloqueado,
3x introdução do PIN
errado, selecionado para
revista aleatória) na tela
principal de dados
pessoais.
Os dados podem ser
filtrados de acordo com
quaisquer ou com todos os
filtros disponíveis. Múltiplos
filtros funcionam de forma
restritiva (AND lógico).
Por exemplo, é possível
procurar todas as pessoas
cujo nome comece por A e
cujo número do cartão se
encontre na faixa de 900 a
999.
O caractere * pode ser
utilizado como um
caractere universal para
representar qualquer ou
nenhum caractere.
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Layout Filtros disponíveis Descrição

Pessoas -
Autorizaçõ
es

Sobrenome
Nome
Nº da matrícula
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)
Autorizações

Apresenta a lista de
pessoas e as respectivas
autorizações atribuídas. As
autorizações de grupo são
marcadas com (G) e as
autorizações individuais
com (E). Também é
mostrado o tempo de
validade.
É possível filtrar baseando-
se em uma ou em múltiplas
autorizações. Cada
autorização pode ser
selecionada ou removida a
seleção com um simples
clique.

Pessoas -
Áreas

Sobrenome
Nome
Nº da matrícula
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)
Localizações

Baseando-se nas áreas
configuradas no sistema,
são listados os nomes e
número de pessoas em uma
determinada localização.
É possível filtrar baseando-
se em uma ou em múltiplas
áreas. Cada área pode ser
selecionada ou removida a
seleção com um simples
clique.

Autorizaçõ
es -
Pessoas

Autorizações Apresenta a lista de
autorizações e as pessoas a
elas atribuídas. As
autorizações de grupo são
marcadas com (G) e as
autorizações individuais
com (E). Também é
mostrado o tempo de
validade.
É possível filtrar baseando-
se em uma ou em múltiplas
autorizações. Cada
autorização pode ser
selecionada ou removida a
seleção com um simples
clique.
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Layout Filtros disponíveis Descrição

Dispositivo
s:

Tipo de dispositivo
Descrição do
dispositivo

Apresenta a lista de tipos
de dispositivos
(controladores, entradas,
leitores).
É possível filtrar baseando-
se em um ou em múltiplos
tipos de dispositivos. Cada
tipo de dispositivo pode ser
selecionado ou removida a
seleção com um simples
clique.
Os dispositivos podem ser
filtrados por
correspondências de texto
nas respectivas descrições.
Por ex., todos os
dispositivos cujas
descrições comecem por
um A.
O caractere * pode ser
utilizado como um
caractere universal para
representar qualquer ou
nenhum caractere.

Usuários Sobrenome
Nome
Nº da matrícula
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)

Apresenta a lista de
pessoas que são também
usuários do sistema e os
respectivos direitos de
usuário atribuídos
Os dados podem ser
filtrados de acordo com
quaisquer ou com todos os
filtros disponíveis. Múltiplos
filtros funcionam de forma
restritiva (AND lógico).
Por exemplo, é possível
procurar todas as pessoas
cujo nome comece por A e
cujo número do cartão se
encontre na faixa de 900 a
999.
O caractere * pode ser
utilizado como um
caractere universal para
representar qualquer ou
nenhum caractere.
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Layout Filtros disponíveis Descrição

Pessoas -
Portas

Sobrenome
Nome
Nº da matrícula
Nº do crachá
Card no. from ...
to (Nº do cartão
de ...a)
Dept./Company
(Depto/Empresa)
Personnel Group
(Grupo de
pessoas)
Autorizações

Apresenta a lista de
pessoas e as respectivas
portas atribuídas. As
autorizações de grupo são
marcadas com (G) e as
autorizações individuais
com (E). Também é
mostrado o tempo de
validade.
As pessoas podem ser
filtradas por
correspondências de texto,
por ex., todas as pessoas
cujos nomes comecem por
A.
O caractere * pode ser
utilizado como um
caractere universal para
representar qualquer ou
nenhum caractere.

6.2 Relatórios: Visualização da página
É possível definir filtros para limitar o conteúdo do relatório a um subconjunto. Se nenhum
filtro for definido, todos os dados serão apresentados. O botão Procurar ativa a coleta de
dados e a sua exibição em uma janela de pré-visualização.

Aviso!
Ao alterar critérios de filtragem, é recomendável usar o botão Limpar formulário para evitar
uma filtragem não intencional e, assim, equívocos nos relatórios.

Os arquivos de histórico de eventos abertos podem ser salvos ou impressos. O item de menu

File > Print (Arquivo > Imprimir) ou o botão  permite abrir uma pré-visualização.
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Aviso!
Todos os arquivos de histórico de eventos abertos serão impressos.
Feche todos os arquivos que não devem ser impressos ou restrinja a seleção às mensagens
importantes.

A visualização da página do relatório oferece ferramentas para modificar e manipular a
exibição:

Botão Significado Descrição

Exportar A lista pode ser exportada para
um arquivo para processamento
posterior. Estão disponíveis os
seguintes formatos:
Acrobat Portable Document
Format (PDF)
Valores Separados por Vírgulas
(CSV)

Imprimir Imprime o relatório por meio de
uma caixa de diálogo de
impressão que permite a
configuração de uma impressora
predefinida.

Selecionar
página

Os botões de seta levam para a
primeira página, página anterior,
página seguinte ou última página
do relatório. O controle também
mostra o número total de páginas
e a página onde se encontra neste
relatório.

Nº de
páginas

Solicita a página atual e o número
total de páginas.
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Botão Significado Descrição

Zoom A escala padrão de visualização
(100 %) pode ser alterada como
desejado.

Exportar listas
Pressione o botão  para abrir uma caixa de diálogo que definirá os critérios de exportação.

O campo da lista de seleção Format (Formato) oferece os formatos de saída .pdf (para
encaminhar e arquivar resultados específicos de procura) e .csv (para outros dados de
processamento).
Durante a exportação dos dados para um arquivo csv, estes poderão sofrer um determinado
processamento.

Da mesma forma que pode introduzir um Delimiter (Delimitador) e o modo de exportação
(Mode), é possível também excluir ou isolar da exportação Report and Page sections (Seções
do relatório e de páginas) (cabeçalhos de colunas e detalhes da página) e Group sections
(Seções do grupo) (dados selecionados).
Você pode selecionar uma das seguintes opções como Destination (Destino).
– Application (Aplicativo) — abre o arquivo usando o aplicativo adequado. Este aplicativo

deve estar instalado no computador. Os arquivos pdf são abertos no Adobe Acrobat
Reader e os arquivos csv, no MS Excel.
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– Disk file (Arquivo de disco) (predefinido) — abre uma caixa de diálogo do Explorer para
selecionar o diretório necessário. É sugerido um nome para salvar o arquivo.

– Exchange folder (Pasta de intercâmbio) — o arquivo pode ser diretamente enviado para
um destinatário do MS Outlook.

– Lotus Domino Mail — o arquivo pode ser diretamente enviado para um destinatário do
Lotus Mail.
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7 Gravações locais
Gravando imagens fixas e vídeos
As sequências de vídeo exibidas através das caixas de diálogo de controle de acesso são
retiradas dos dispositivos de gravação de vídeo aos quais as câmeras de vigilância
configuradas estão conectadas. Dependendo da capacidade de armazenamento do
dispositivo, as gravações mais antigas serão excluídas à medida que gravações mais novas as
substituírem (buffer circular).
Para salvar determinadas seções, é possível salvar cópias locais de imagens ou vídeos
individuais. Se você usar o caminho de instalação padrão, as imagens e os vídeos serão
armazenados em C:\BOSCH\Access Professional Edition\PE\Data\Video.

Pressione o botão  para armazenar uma imagem fixa em formato jpg como <nome do
dispositivo>_yyyyMMddhhmmsstttt.jpg
[a= ano, M= mês, d= dia, h= hora, m= minuto, s= segundo, t= milésimo de segundo].

Pressione o botão  para iniciar a gravação da sequência que está em execução no
momento e pressione-o novamente para encerrar a sequência. Essa cópia local da gravação de
vídeo recebe um nome da mesma forma que as imagens e é armazenada em formato .vxx
ou .mpeg. O formato .vxx não pode ser exibido como vídeo com aplicativos comuns
disponíveis no mercado. Para exibir essas cópias locais, use o Bosch Video Player fornecido.

Pressione o botão  para armazenar uma imagem fixa da exibição atual de um Ponto de
interesse Point (POI). _POI é adicionado no início do nome do arquivo: _POI <nome do
dispositivo>_yyyyMMddhhmmsstttt.jpg.
[a= ano, M= mês, d= dia, h= hora, m= minuto, s= segundo, t= milésimo de segundo].
Uma mensagem também é criada no histórico de eventos como um marcador.

Bosch Video Player
Enquanto as imagens fixas podem ser abertas com praticamente qualquer programa de
visualização de imagens ou um navegador da Internet, as gravações de vídeo têm um formato
especial e necessitam do Bosch Video Player.

Aviso!
Você pode usar qualquer player para exibir sequências de vídeo salvas em formato .mpeg.

A caixa de diálogo é deliberadamente simples e possui apenas dois botões próximos ao
campo de exibição de vídeo, denominados abrir arquivo e iniciar/parar.
Pressione abrir arquivo para procurar a localização de armazenamento de gravações de vídeo
padrão (C:\) para os arquivos necessários.
Após selecionar o arquivo de vídeo, o caminho será exibido no Video Player. Agora você
poderá exibir o arquivo a qualquer momento ao pressionar o botão iniciar. Enquanto o vídeo
estiver sendo reproduzido, o botão de início será alterado para parar para permitir a
interrupção da reprodução.
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8 Direitos de usuário
Os direitos de usuário para os aplicativos do Access PE (assim como dos usuários do
Configurador e do Visualizador do histórico são atribuídos em Gerenciamento de funcionários,
em uma guia especial de dados de funcionários (= Direitos de Usuário).

8.1 Direitos de usuário
Esta guia somente fica visível se o usuário atualmente conectado tiver direitos de
administrador. Somente os administradores podem definir e modificar os seus próprios
direitos e os dos outros.

Se uma pessoa tiver que receber direitos de usuário para aplicativos do Access PE, então
estes devem ser explicitamente atribuídos. Por predefinição, todas as pessoas estão
configuradas sem direitos de usuário.
Os direitos de usuário podem ser atribuídos introduzindo um nome de usuário e uma senha.
Por predefinição, é sugerido o sobrenome da pessoa como o nome de usuário, mas isto é
arbitrário. A senha pode ter, no máx., 16 caracteres, é sensível a letras maiúsculas e
minúsculas e pode conter quaisquer caracteres especiais.

Aviso!
É altamente recomendado a criação de um usuário individual para cada pessoa que irá utilizar
o sistema. Não crie um usuário genérico com o qual diversas pessoas trabalharão. Todas as
inserções de dados, modificações etc. são registradas sob o nome do usuário que as efetuou,
mas isto somente faz sentido se cada usuário tiver a sua própria senha e alterar as
configurações de usuário (Transferência de usuário e segurança da estação de trabalho, página
65) conforme necessário quando partilhar a estação de trabalho com outra pessoa.
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A instalação predefinida contém um administrador predefinido. Assim, quando estes usuários
predefinidos estão logados, é possível criar e modificar qualquer outro tipo de usuário ou
administrador.
Os administradores diferem dos usuários normais apenas na capacidade para administrar
direitos de usuários. Não existe diferença entre os tipos de usuários no que diz respeito à
disponibilidade dos aplicativos ou ao acesso a dados e arquivos de histórico de eventos. Cada
um dos usuários pode ser configurado com acesso de dados restrito ou não restrito.
Se for selecionada uma das opções de administrador, então os vários grupos de direitos de
usuário para aplicações do Access PE tornam-se ativos e podem ser atribuídos
individualmente.
Detalhadamente, os direitos de usuário que podem ser atribuídos são os seguintes:

Aplica
tivo

Direito de
usuário

Descrição

Dados de
funcionário
s

Ver dados
de
funcionário
s

Somente a caixa de diálogo com
dados de funcionários pode ser
acessada. As localizações das
pessoas não são exibidas. Não são
permitidas modificações.

Editar
dados de
funcionário
s

Os dados dos funcionários podem
ser vistos e modificados. As
localizações das pessoas não são
exibidas.

Alterar
localização

Somente pode ser usada em
conjunto com uma das opções
acima mencionadas.
Se a opção Ver dados de
funcionários estiver ativada, as
localizações poderão ser somente
exibidas.
Se a opção Editar dados de
funcionários estiver ativada, as
localizações poderão ser
modificadas.

Alterar
autorizaçõe
s

A guia Autorizações de acesso só
torna-se ativa quando esta caixa
está selecionada.

Configurad
or

Configuraç
ão do
sistema

Ativa os direitos de usuário
completos para o Configurador.

Gerenciam
ento da
porta

Abrir/travar
porta
(longo
tempo)

O gerenciamento da porta é
ativado pelo menu do mesmo
nome e através do menu de
contexto na lista de status do
dispositivo (no Gerenciamento de
funcionários e no Visualizador do
histórico).
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Aplica
tivo

Direito de
usuário

Descrição

Visualizado
r do
histórico

Ver própria
mensagem

Filtra todas as mensagens de
histórico de eventos exceto
aquelas pertencentes ao próprio
usuário.

Ver todas
as
mensagens
sem dados
pessoais

Mostra todas as mensagens do
histórico de eventos, mas aplica
uma máscara nos dados pessoais.

Ver todas
as
mensagens

Mostra todas as mensagens do
histórico de eventos sem restrição.

Os direitos de usuário ativos estão marcados na caixa de verificação e com o símbolo  ao
lado. A seguinte imagem mostra a ativação de todos os direitos. Todas as caixas podem ser
marcadas sem receio de conflitos de direitos, uma vez que o conjunto de direitos mais
abrangente terá precedência.
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8.2 Configuração dos direitos de acesso do usuário
O sistema é fornecido com direitos de Usuário-Administrador pré-configurados.
Por predefinição, é fornecido um nome de usuário e senha Bosch a um usuário.
Apenas os administradores estão autorizados a configurar outros usuários.

!

Advertência!
Este usuário e sua senha faz parte do fornecimento padrão e não está personalizado para
cada comprador do software. Por isso é recomendado, antes de entrar em uso de produção,
que os use primeiro para configurar as suas próprias contas com privilégios de administrador
e em seguida excluir ou modificar o original.

Configure outros usuários da seguinte forma:
1. Inicie o Access PE - Gerenciamento de funcionários usando o ícone da área de trabalho

 e inicie a sessão com a conta de Usuário-Administrador pré-configurada.

2. Abra a caixa de diálogo para adicionar os dados dos funcionários usando o botão 
ou o menu Pessoas > Nova pessoa

3. Adicione um novo usuário especificando, pelo menos, o nome e o grupo de funcionários
4. Clique na guia Direitos do Usuário e

– altere o nome do usuário, se necessário
– atribua uma senha.
– defina o tipo de usuário (Usuário ou Usuário-Administrador).
– atribua a este usuário os direitos para modificar dados.
– Confirme os dados introduzidos e feche a caixa de diálogo clicando em OK.

5. Encerre a sessão do Gerenciamento de funcionários clicando em  ou através do
menu Extras > Iniciar sessão e confirmando a verificação de segurança respondendo
Sim.

6. Volte a usar o botão  ou o menu para iniciar a sessão usando as credenciais do
usuário que acabou de criar.

8.3 Transferência de usuário e segurança da estação de trabalho
Transferência de usuário
Se um usuário ceder o controle a outro usuário na mesma estação de trabalho, a transferência
deve ser efetuada explicitamente no sistema. Esta transferência pode ser desempenhada com
o sistema em execução - não é necessário reiniciar o Access PE.

Primeiro, o usuário atual deve encerrar a sessão. Para fazer isso, clique no botão  na
barra de ferramentas. Segue-se uma verificação de segurança: Deseja encerrar o trabalho
com direitos de usuário?
Após confirmação, o sistema retorna à exibição predefinida.
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O novo usuário inicia sessão (login) novamente usando o botão .

Segurança da estação de trabalho
No caso de estações de trabalho temporariamente desocupadas em locais acessíveis ao
público é crucial proteger os dados pessoais contra o acesso não autorizado. Estão
disponíveis várias medidas para este fim:
– Como regra geral, não deve ser instalado o Configurador nem o Visualizador do histórico

em tais estações de trabalho.
– Termine a sessão do Gerenciamento de funcionários sempre que não estiver sendo

usado através do botão  com verificação de segurança, tal como acima descrito. A
lista de funcionários permanece visível, mas os dados pessoais já não podem ser
acessados.

– Feche o aplicativo através de Arquivo > Sair ou através do botão x na barra de título do
Windows. O aplicativo deverá ser reiniciado para ver a lista de funcionários.

– Bloqueie o computador usando a função padrão do Windows: pressione Ctrl + Alt + Del
e selecione Bloquear Computador das funções do sistema aqui oferecidas. Uma vez que
esta é a função predefinida, Bloquear computador pode ser rapidamente alcançada
pressionando simplesmente em RETURN. Somente o usuário atual ou um administrador
do sistema Windows pode agora desbloquear o sistema.
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9 Requisitos da UL 294
Recursos não avaliados pela UL:
– O Sistema de verificação de vídeo
– Visualizador de mapas e o gerenciamento de alarmes com verificação por mapas e vídeo
– Aparelho de vídeo
– Badge Designer
– O Delta 1200 Series
– Rosslare ARD-1200EM Series
– Controladores LAC
– Controladores LACi
– Controladores APC-AMC2-4R4CF

– Protocolo de interface do leitor BG 900
– Protocolo de interface do leitor L-BUS

– Sistema de segurança IDS - Arme/Desarme
– Uso de elevador
– Textos
– Histórico de eventos
– Gerenciamento de pessoas
– Criação de cartões
– Relatórios
– Direitos de usuário
– Uso do alarme contra roubo

Recursos avaliados pela UL:
– Leitores de formato Wiegand de 26 bits
– Controladores AMC2:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW como equipamento de monitoramento suplementar
Os seguintes leitores de cartão de modelo Bosch foram avaliados pela UL quanto à
compatibilidade com o sistema do software do APE-SW da Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI
– LECTUS secure 5000 WI
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